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ADuCM310 Development Systems Getting Started Tutorial

DEVELOPMENT SYSTEM KIT CONTENTS

Evaluation board (EVAL-ADUCM310QSPZ) that facilitates
performance evaluation of the device with a minimum
of external components

Analog Devices, Inc., J-Link OB emulator
(USB-SWD/UART-EMUZ)

1 USB cable

1 installation DVD

INTRODUCTION

The ADuCM310 is a multidie stack system on-chip for
diagnostic control of tunable laser optical module applications.
The ADuCM310 features a 14-bit, multichannel, successive
approximation register analog-to-digital converter (SAR ADC);
an ARM? Cortex-M3 processor; eight voltage DACs; six current
output DACs; and Flash/EE memory packaged in a 6 mm x 6 mm,
112-ball CSP_BGA package.

GENERAL DESCRIPTION

The ADuCM310 development system allows evaluation of
ADuCM310 silicon. This quick start guide introduces the
support features and the tools supplied with the evaluation kit.
In addition, this user guide shows and describes how to connect
the evaluation hardware.

This user guide works as a tutorial by providing a step-by-step
account of how to download evaluation versions of third-party
software tools. Instructions are provided on how to load code
examples that are supplied.

By working through this guide, users can start to generate and
download their own user code for use in their own unique end-
system requirements.

Full specifications on the ADuCM310 are available in the
product data sheet, which should be consulted in conjunction
with this user guide when working with the evaluation kit.

TYPICAL SETUP
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Figure 1. EVAL-ADUCM310QSPZ Evaluation Board and Analog Devices J-Link OB Emulator

PLEASE SEE THE LAST PAGE FOR AN IMPORTANT
WARNING AND LEGAL TERMS AND CONDITIONS.
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GETTING STARTED

SOFTWARE INSTALLATION PROCEDURES

Perform the steps described in this section before plugging any
of the USB devices into the PC.

1. Close all open applications.

2. Insert the installation DVD into your DVD drive.

3. Double-click ADuCM310.exe and follow the on-screen
instructions. A dialog box displays installation options, as
shown in Figure 2.

= e G

Check the components wou want to install and uncheck the components
you don't want to install, Click Mext to continue,

E ADUCM310V1.2 Setup: Installation Opticns

Select the type of install:

ADUCM310 4 Keil

O, select the optional
components you wish to install:

ADUCM3L0 (required)

Keil uvision 5

CMSIS Pack for ADWCM310 (For Keil)
[ 18R Embedded Warkbench

FTDI Driver

PLATOOIM3

Segger J-Link Software

Space required: 885.8MB

Cancel

< Back | Mexk = |

Figure 2. Installation Options
The following are installed on the PC by default:

e  Example code and function sets for most peripherals

e  Elves.exe: an application with which functions can be easily
chosen from the provided function sets; the user can then
choose the function parameters.

e CM3WSD.exe: an application for downloading hex file to
the ADuCM310 over UART.

The user also has the option to install the following:

e  Keil development tools (compiler, debugger, and
programming tools). The revision used is V5.14. Analog
Devices has developed a CMSIS software pack to support
the ADuCM310.

e TAR development tools (compiler, debugger, and
programming tools).
e  FTDI drivers for the evaluation board.

e  PLAToolM3: an application for configuring the PLA
peripheral on the ADuCM310.

Segger J-Link software: this is the software and drivers for
the emulator.

The Segger J-Link software is selected by default in the installation
menu. It is advised to leave it selected, which automatically
installs the J-Link serial port driver. Select Install USB Driver
for J-Link-OB with CDC, as shown in Figure 3. If this step is

13100-002

missed, run Setup_JLink_Vxxxx.exe located in the Segger folder
on the DVD. After this step, if there is an issue with the drivers,
the drivers can be reinstalled from Program Files\SEGGER\
JLinkARM_ Vxxxx\USBDriver. The CDC driver must be
installed.

,
5 Croose cpiond TR

o |
Chooze optional components that should be installed:
¥ Ingtall USB Drives for J-Link
W Install USE Driver for J-Link-OB with COC

Choose oplions for creating shortcuts

¥ Create entiy in stait menu
[~ Add showteuts to deskiop

Cancel |

13100-003

Figure 3. Installing J-Link Software

If the IAR tools are to be used, the entire contents of the
supplied arm directory (for example, C:\ADuCM310...\
TAR\IAR_M310_Patch.zip\arm) must be copied to the IAR
tools directory (for example, C:\Program Files\IAR Systems\
Embedded Workbench 7.2\arm).

Future updates will be available from the Analog Devices
FTP site.

1.  When the software installation is completed, plug the
debugger/programmer into the USB port of your PC using
the USB cable supplied.

2. Verify that the emulator board appears in the Windows®
Device Manager (see Figure 4).

2 Device Manager =8| 2
File Action  View Help
% |m|Hrml &
TH Ponts [COM & LPT)
B rrocessees
9 Security Devices
T Smnart card rraders
& Sound, viden and game contrellers
1 Yytem deaces
4§ Universal Seral Bus comarotiers
# Genenc USE Hub
W Genenic USE Hub
W Genenic USE Hub
W Genenic USE Hub
W Genenic USE Hub
W Genenic USE Hub
W Genenic USE Hub
W InRei(R) § Serves/3400 Serses Chipset Family USE Enhamced Host Cortrolier - 3634

§_InBelEy S Seres 3400 Serves Chipset Family USE Enkamced Host Comtrolier - 3830
) |._ TrRE Device

§ USB Composite Device
@ USE Compesite Device
@ USE Compesite Device
@ USE Mass Storage Device
@ USE Reot Hub

@ USE Reot Hub

# USE Serial Converter

13100-004

Figure 4. Device Manager
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EVALUATION BOARD SETUP PROCEDURES
Assembling the Hardware

Do not plug in the USB cable before the software is installed.
Connecting the Hardware

Take the following steps to connect the hardware:

1. Insert the USB cable provided between the PC and the
J-Link OB emulator.

2. Thered LED (LED1) flashes briefly until initialization of
the drivers is complete.

3. Driver installation details may appear on your screen;
allow the installation of these drivers to complete, because
these drivers provide a virtual communication port on
your PC, allowing the evaluation board to appear as a
virtual serial communication port to the UART port of the
ADuCM310 device.

4. Note that the emulator drives P1.0 of the ADuCM310 high.

If P1.0 is needed for other uses, LK5 on the emulator can
be removed.

5. If the virtual serial communication port to the UART is to
be used, ensure that Jumper LK3 and Jumper LK5 are in
place (see Figure 6). If the UART on J8 is to be used, LK3
and LK5 must be removed to prevent contention.

6. Plug the 10-pin DIL connector of the J-Link OB emulator
into the EVAL-ADUCM310QSPZ.

7. To power up the evaluation board, apply a 2.5 V supply
capable of providing up to 2 A of current for the IDACs,
and one of the following:

e A voltage between 6 V and 20 V to J5.
e A voltage between 6.7 V and 20 V to J1. Note that the
J1 connector is center ground and outside positive.

8. The green power LED turns on.

e \

u ANALOG
DEVICES

Rev B
USB-SWD/UART-EMUZ

13100-005

Figure 5. Emulator, Top View
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TO MINIKIT BOARD CONNECTOR

Figure 6. J-Link OB Connection Details

KEIL pVISIONS

The Keil pVision5 integrated development environment (IDE)
integrates all the tools necessary to edit, assemble, and debug
code. The free version that ships with the ADuCM310
evaluation kit is limited to 32 kB code.

Starting pVision5

First, ensure that the CMSIS pack for the ADuCM310 has been
installed (see the Software Installation Procedures section).

After installing Keil uVision5, a shortcut appears on the
desktop. Double-click the shortcut to open Keil uVision5.

Vs

Figure 7. Keil uVision5 Desktop Shortcut

13100-007

1.  When Keil opens, click the Pack Installer button on the
toolbar.

13100-008

Figure 8. Pack Installer Button
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2. The Pack Installer window opens.

e Packa edom Hielp
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3. From the right-hand portion of the window, under the
Devices tab, click Analog Devices > ADuCM310 Series >

Figure 9. Pack Installer Window

ADuCM310.

4| Devices | Boards |

Search:

- X

Device

/| Summary

[ ¥ Analeg Devices
[0 ADUCM36x Series
£t ADUCM310 Series |1 Device

14 Devices

2 Devices

AD 0 ARM Cortex-M3, 80 MHz, 32 kB RAM, 256 kB ROM

4% ADUCM320 Series |1 Device

% CMiox Mixed Sig..[10 Devices

Figure 10. Devices Tab
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4. In the left-hand side of the window, click the Examples tab.
I se’| Device:  Analog Devices - ADUCM310
4] " Packs ' Examples |

I I_ Show examples from installed Packs only
Example Action
------ ADC_DMA (EVAL-ADuCM310EBZ) 1 Copy |
------ ADC_DMA_SEQ (EVAL-ADUCM310EBZ) ! Copy |
------ ADC_Demo (EVAL-ADuCMS310EBZ) ! Copy |
------ Blinky (EVAL-ADuCM310EBZ) 1 Copy |
------ DIO (EVAL-ADUCMI10EBZ) ! Copy |
------ Flash (EVAL-ADuCM310EEZ) ! Copy |
------ GPT (EVAL-ADUCM310EEZ) ! Copy |

g ------ I2CBasic_Slave (EVAL-ADUCM310EEZ) 1 Copy |
= o I2CEEPROM_Master (EVAL-ADuCM310EBZ) ! Copy |
------ I2CEEPROM_Slave (EVAL-ADuCM310EBZ) ! Copy |
------ I2cBasic_Master (EVAL-ADUCMS310EBT) 1 Copy |
------ IDAC_Demo (EVAL-ADuCM310EBZ) 1 Copy |
------ MVIC_Deme (EVAL-ADuCM310EBL) ! Copy |
------ PWM (EVAL-ADUCMS10EBZ) ! Copy |
------ RTX_Blinky (EVAL-ADuUCM310EBZ) 1 Copy |
------ SPIDMA_Master (EVAL-ADUCMZ10EBL) ! Copy |
------ SPIDMA_Slave (EVAL-ADuCM310EBZ) ! Copy |
------ 5PI_Master (EVAL-ADuCMS310EBZ) 1 Copy |
------ 5P1 Slave (EVAL-ADUCMZ10EEL) ! Copy |
------ UART (EVAL-ADuCM310EBZ) ! Copy |
------ VDAC_Deme (EVAL-ADuCM310EBZ) 1 Copy |
------ WDT (EVAL-ADUCM310EBZ) ! Copy |
------ WUT (EVAL-ADuCM310EBZ) ! Copy |
Figure 11. Examples Tab
5. Select the DIO example and click copy.
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6. Choose a destination folder and click ok. It is recommended
to place your projects under C:\ADuCM310Vx.x\code\
ADuCM310\MyProjects. This copies the DIO example,
necessary startup files, and library functions to the folder
of your choice.

[ CAADUCM310V1.2\code\ADUCM310WMyProject

File Edit View Project Flash Debug Peripherals Tools SVCS  Window Help
SHd . @ | | m | = = | @ «
® & @ 0| W) oo EREERRS
Project n @ _] T
=% Project: DIO *15‘“*7
= sz DIO z EEREEEE
=iF Source Group 1 Bexam
. 4 Bhrie
1 main.e 5
4 avss 5
£ 4 Device 7 Bvers
] DioLib.c (Peripheral Libraries:DIO) 8 Baurh
=) d
_] DioLib.h (Peripheral Libraries:DI0) g ? SEE\
J WtLib.c (Peripheral Libraries:WDT) 11
J WatLib.h (Peripheral Libraries:WDT) 1z
] startup_ ADUCM310.5 (Startup) 13 | A1l file:
14 provided
] system_ADUCM310.c (Startup) 1 | i
16 | It is th

Figure 12. DIO Example

7. The example must to be compiled by clicking the Build
button on the toolbar, or by pressing the F7 key.

e 5

Build (F7)
Build target files

13100-013

Figure 13. Build Button

8.  When the build has completed, the message shown in
Figure 14 appears.

Build Output

Build target 'DIC

compiling wain.c. ..

cowpiling DioLib.c...

compiling WdtLib.cz...

assenbling startup ADuCHMI1O.=. ..

compiling system ADOCHM3I10.c...

linking...

Prograwm Size: Code=560 RO-data=316 EW-dats=16 ZI-data=1024
FrowmELF: creating hex file...

" hobiWDIO.axf" - 0 Erroris), O Warningi(s).
Build Time Elapsed: 00:00:12

13100-014

Figure 14. Build Output

9. To download the code to the EVAL-ADUCM310QSPZ
board, click the Download button.

=

K il LoAD

1@ 0|88 oo

+ DIO fg Download .
- Download code to flash memaory g

I3
Figure 15. Download Button

10. When the download is complete, the message shown in
Figure 16 appears.

Build Qutput

13100-012

JLink info:

DLL: W4.96d, compiled Jan 29 2015 11:45:37

Firmware: J-Link Lite-ADI Rew.l compiled Jan 7 2013 17:58:04
Hardyare: Vi1.00

3/ 1 54

COEM : ADI

* JLink Info: Found 3WD-DP with ID Ox2BA0D1477

* JLink Info: Found Cortex-M3 rZpl, Little endian.

* JLink Info: FPUnit: 2 code (BP) slots and 0 literal slots
RCONTableklddr = OxEQOFFOO3

Target info:

Device: ADuCH310

VTarget = 3.607V

State of Pins:

TCE: 0, TDI: 0, TDO: 0O, THS: O, TRES: 1, TRIT: 1
Hardware-Breakpoints: 2

SGoftware-Breakpoints: 5192

Watchpoints: 1

JTAG speed: 1000 kH=

Full Chip Erase Done.
Programming Done.
Verify OK.

Flash Load finished at 1Z:30:34
Figure 16. Download Message

11. After the code is downloaded to the board, press the reset
button on the evaluation board. The red DISPLAY starts

toggling.
12. The code can be debugged by clicking the Debug button.

@) e o & &) A

@ Start/5top Debug Session (Ctrl+F5)
Enter or leave a debug session

13100-017

Figure 17. Debug Button

13. Breakpoints can be added by clicking the breakpoint
button. The ADuCM310 is limited to two hardware

13100-016

breakpoints. The J-Link software comes with an evaluation

version of unlimited flash breakpoints, which work by
reprogramming the ADuCM310 flash to add a special
instruction that the debugger is aware of.

14. The execution of the code on the ADuCM310 can be
controlled using the Debug toolbar. The ADuCM310 can
be reset, the program can be started and stopped, and it is
possible to step through the code. Note that stepping
through the code uses one of the two available hardware
breakpoints.

SEO| BE G n o

Figure 18. Debug Toolbar

13100-018
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15. The registers for the various peripherals on the ADuCM310 A Manage Run-Time Environment
can be viewed by going to the Peripherals menu and
. . . Software Component Sel.  Variant Version
selecting the System Viewer submenu. The registers can be @ cvss
-
read and written to here. The registers can also be expanded & CMSIS Driver
to obtain the bit information and possible enumerations o9 Device
that can be used for certain bits. Note that reading certain ¥ Startup I+ 1040
. . . =] ‘ Peripheral Libraries
status registers or reading from FIFO registers can affect
) : . @ ADC r 100
the normal operation of code; therefore, the user is advised @ DAC - 100
to be cautious with the use of System Viewer. @ Do G 100
@ DMA r 100
I @ FEE I~ 1.0.0
| @ GpPT |— 1.0.0
@ nc ~ 100
@ IDAC r 100
@ INT r 100
@ pwm r 100
@ sl r 100
@ UART r 100
¥ WDT I3 1.0.0 §
¢ wut - 100 g

Figure 21. Adding Peripheral Libraries to a Project

13100-019

17. The libraries are documented with Doxygen comments,

Figure 19. System Viewer Menu
g 4 which can be interpreted by the Elves program. The Elves

16. After a debug session is complete, new code can be written program provides a GUI that can be used to select the
and rebuilt. Included in the evaluation kit is an extensive correct parameters to be passed toa library function. For
set of library functions. These can be included in a project more information, see the Elves section.

with the Manage Run-Time Environment button. The
libraries can be found under the Device > Peripheral
Libraries category, as shown in Figure 21.

@ @&
‘ Manage Run-Time Environment

Select Software Components for the /=
project
26 Hinclude <WdtLib.h>

—~ a - A

13100-020

Figure 20. Manage Run-Time Environment Button
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IAR EWARM

The EWARM integrated development environment (IDE)
integrates all the tools necessary to edit, assemble, and debug
code. The fastest way to get started is to open an existing
workspace by taking the following steps:

1. Open the IAR tools from the start menu, IAR
Systems\...\IAR Embedded Workbench.

2. Within the IAR IDE, click File > Open > Workspace, and
open a workspace provided (for example, C:\ADuCM310...\
code\ADuCM310\examples\DIO\DIO.eww).

3. Compile and download to the device by clicking Project >
Rebuild All, and then clicking Project > Download Active
Application.

4. If a pop-up window about an unknown device appears,
click No.

5. To run the code, press reset on the board or enter debug
mode by using the Download and Debug button and then
clicking Go.

2|2 L

_l Download and Debug h_

Figure 22. Download and Debug Button
=3
252 X

3in.|
A 1
Figure 23. Go Button

6. When the code is running, the red LED marked DISPLAY
on the board flashes.

7. Breakpoints can be enabled using the Toggle Breakpoint
button. The ADuCM310 is limited to two hardware
breakpoints. The J-Link software comes with an evaluation
version of unlimited flash breakpoints, which work by
reprogramming the ADuCM310 flash to add a special
instruction that the debugger is aware of.

13100-022

13100-023

8| ob ol

13100-024

| Toggle Breakpoint h

Figure 24. Toggle Breakpoint Button

8. In debug mode, the execution of the program can be
altered using the Debug toolbar. Note that stepping
through the code uses one of the two available hardware
breakpoints.

13100-025

— : P

Figure 25. Debug Toolbar

9.  The peripheral registers can be read and modified using
the Register window, which can be accessed from the View
menu. Note that reading certain status registers or reading
from FIFO registers can affect the normal operation of
code; therefore, the user is advised to be cautious with the
use of the Register window.

Register x
GRIOO -
O=0000
GPOOE = 0=00
GPOPOL = 0=xFF
GPOIE = 0=xFF
GPOIN = 0O=xFF
GPOOUT = 0=x00
GPOSET = WY
GPOCLR = WY
GPOTGL = WY
HGFOODE = 0=00 g
Figure 26. Register Window
ELVES

Elves.exe is an application that the user can use to easily choose
functions from the provided function sets, and then choose the
function parameters. Elves can be integrated into the Keil and
IAR tools under their tools menus. For instructions, run
Elves.exe (for example, at C:\ADuCM310...\Software Tools\
Elves\Elves.exe) and press the F1 key or click the Help button
for further instructions.

1.

The library files for a particular uVision5 project are copied
by uVision5 from the CMSIS pack to the RTE folder under
the project folder.

All the included libraries are available under
C:\ADuCM310Vx.x\code\ADuCM310\common. These
files can be used for both the IAR and the Keil installation.

*4 Elves

= e

Select Function Set

pdd | Remove| | View Help =

[T

~ Function Detail

C:\ADuCH310VL. 24 code) ADuCH310 | comuont Spilib. h

|
int SpiCly ( pSFI ) FifoSize ) iMasteiEn . iConfig 1

Sowrce Code

Copy
»

et

Bbrief int EpiCfy(iDI_SPI_TypeDef *pEPI, int iFifofize, int iMasterEn, int iConfig);

Eparaw pSPL :{pADI_SPI0, piDI_SPIL}

@parsw iFifoSize : (SPICON_MOD_TX1RXL,SPICON_MOD_TX2EXZ,SPICON_MOD_TXIRXZ,SPICON_MOD_TK4R:

@parsu iMasterEn : (SPICON_MASEN DIS,SPICON_MASEN_EN}

========== Configure the $PI channel.

- pADI_SPIO for SPIO.
- pADI_SPIL for SPIL.

- SPICON_MOD_TXLEX1 for gle byte Bx and Tx FIFO
- SPICON_MOD_TXZRXZ for bytes Bx and Tx FIFO =
- SPICOM_MOD_TX3EX3 for thres bytes Rx and Tx FIFO sizes.
- SPICOM MOD_TH4EX4 for four bytes Rx and Tx FIFD sizes.

- SPICON_MASEN DIS to enable SPI in Slave mode. -
i b

13100-027
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CM3WSD (o, cvawsp SRS )
CM3WSD.exe is an application that can download hex files to File to download
the ADUCM310 over the UART. CM3WSD is installed under [CAADUCHME! 0T 2\codeNADUCHE! TWMyProjects'\DIDVabADIT hex
C:\ADuCM310...\Software Tools\CM3WSD\CM3WSD.exe. S ——
To use this application, the device must be in serial download E;:ds_g [[ Lk CDC UBRT Parl | |_9500 |
mode. Enter serial download mode by pressing the
SERIAL_DOWNLOAD button, which is connected to P2.3 on .
the ADuCM310, and then by resetting the device. fﬁ:j;iz ]
For details of the Cortex-M3 based ADuCxxx serial download [ fuon [ Autoflash
protocol used by CM3WSD, see the AN-1160 Application Note. Maritor Status
Elqnlfgct test board to PC COMES at 3600 Baud.
ick. Start.

[
Start Exit

Figure 28. CM3WSD

13100-028

ESD Caution
ESD (electrostatic discharge) sensitive device. Charged devices and circuit boards can discharge without detection. Although this product features patented or proprietary protection
m circuitry, damage may occur on devices subjected to high energy ESD. Therefore, proper ESD precautions should be taken to avoid performance degradation or loss of functionality.

Legal Terms and Conditions

By using the evaluation board discussed herein (together with any tools, components documentation or support materials, the “Evaluation Board"), you are agreeing to be bound by the terms and conditions
set forth below ("Agreement”) unless you have purchased the Evaluation Board, in which case the Analog Devices Standard Terms and Conditions of Sale shall govern. Do not use the Evaluation Board until you
have read and agreed to the Agreement. Your use of the Evaluation Board shall signify your acceptance of the Agreement. This Agreement is made by and between you (“Customer”) and Analog Devices, Inc.
("ADI"), with its principal place of business at One Technology Way, Norwood, MA 02062, USA. Subject to the terms and conditions of the Agreement, ADI hereby grants to Customer a free, limited, personal,
temporary, non-exclusive, non-sublicensable, non-transferable license to use the Evaluation Board FOR EVALUATION PURPOSES ONLY. Customer understands and agrees that the Evaluation Board is provided
for the sole and exclusive purpose referenced above, and agrees not to use the Evaluation Board for any other purpose. Furthermore, the license granted is expressly made subject to the following additional
limitations: Customer shall not (i) rent, lease, display, sell, transfer, assign, sublicense, or distribute the Evaluation Board; and (i) permit any Third Party to access the Evaluation Board. As used herein, the term
“Third Party” includes any entity other than ADI, Customer, their employees, affiliates and in-house consultants. The Evaluation Board is NOT sold to Customer; all rights not expressly granted herein, including
ownership of the Evaluation Board, are reserved by ADI. CONFIDENTIALITY. This Agreement and the Evaluation Board shall all be considered the confidential and proprietary information of ADI. Customer may
not disclose or transfer any portion of the Evaluation Board to any other party for any reason. Upon discontinuation of use of the Evaluation Board or termination of this Agreement, Customer agrees to
promptly return the Evaluation Board to ADI. ADDITIONAL RESTRICTIONS. Customer may not disassemble, decompile or reverse engineer chips on the Evaluation Board. Customer shall inform ADI of any
occurred damages or any modifications or alterations it makes to the Evaluation Board, including but not limited to soldering or any other activity that affects the material content of the Evaluation Board.
Modifications to the Evaluation Board must comply with applicable law, including but not limited to the RoHS Directive. TERMINATION. ADI may terminate this Agreement at any time upon giving written notice
to Customer. Customer agrees to return to ADI the Evaluation Board at that time. LIMITATION OF LIABILITY. THE EVALUATION BOARD PROVIDED HEREUNDER IS PROVIDED “AS IS” AND ADI MAKES NO
WARRANTIES OR REPRESENTATIONS OF ANY KIND WITH RESPECT TO IT. ADI SPECIFICALLY DISCLAIMS ANY REPRESENTATIONS, ENDORSEMENTS, GUARANTEES, OR WARRANTIES, EXPRESS OR IMPLIED, RELATED
TO THE EVALUATION BOARD INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF MERCHANTABILITY, TITLE, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF INTELLECTUAL
PROPERTY RIGHTS. IN NO EVENT WILL ADI AND ITS LICENSORS BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES RESULTING FROM CUSTOMER'’S POSSESSION OR USE OF
THE EVALUATION BOARD, INCLUDING BUT NOT LIMITED TO LOST PROFITS, DELAY COSTS, LABOR COSTS OR LOSS OF GOODWILL. ADI'S TOTAL LIABILITY FROM ANY AND ALL CAUSES SHALL BE LIMITED TO THE
AMOUNT OF ONE HUNDRED US DOLLARS ($100.00). EXPORT. Customer agrees that it will not directly or indirectly export the Evaluation Board to another country, and that it will comply with all applicable
United States federal laws and regulations relating to exports. GOVERNING LAW. This Agreement shall be governed by and construed in accordance with the substantive laws of the Commonwealth of
Massachusetts (excluding conflict of law rules). Any legal action regarding this Agreement will be heard in the state or federal courts having jurisdiction in Suffolk County, Massachusetts, and Customer hereby
submits to the personal jurisdiction and venue of such courts. The United Nations Convention on Contracts for the International Sale of Goods shall not apply to this Agreement and is expressly disclaimed.
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